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If the suffix -ology  means the study of, then why does archaeology involve the study of humanity rather than 

the study of archaea? Archaea are a phylogenetically distinct prokaryotic domain of life described first by Woese 

& Fox (1977). They are believed to have first originated on Earth more than 2.5 billion years ago (Gribaldo & 

Brochier-Armanet, 2006) 30 years ago where we became alerted to their presence. It seems a 

bit anthropocentric to name archaeology for humans when archaea have us beaten us to existence on this planet 

by orders of magnitude. 

 

I graduated in 2013 from the University of Central Florida with a degree that up until the last semester of my 

senior year was known as Molecular & Microbiology. In my four years of undergraduate coursework, only 23 

pages of my textbooks were reserved for archaebacteria despite being one of the main three branches on the tree 

of life. I am appreciative of my time in the Maupin-Furlow Lab at UF because it gave me a greater glimpse into 

a domain that I previously knew so little about. It was there I learned about Haloferax volcanii, a halophile 

endemic to the Dead Sea and presumably other marine environments whose salt concentrations approach 

saturation. I observed the characteristic pink colonies and tinted liquid cultures of H. volcanii, which instantly 

brought me back to my time in Rio Lagartos, Yucatan, Mexico. The waters were a vibrant pink (see cover), just 

like the cultures. It led me to contemplate whether the pink was due to brine shrimp as I had been told, or if 

archaea were the culprit. Based on that curiosity and seeing the versatility of archaea in the lab, I decided to 

make it a focus of my lesson presented here.  

 

 

 

 

 

 

 

 

 

 

We care about eukaryotes because they are responsible for what we eat and much of what we see with our naked 

eye. Bacteria are at the forefront of our minds as we strive to maintain cleanliness and avoid feeling ill. 

 like bacteria and eukaryotes, they tend to be forgotten. 

Hopefully this lesson brings some further recognition to other forms of life around us, both large and small, a 

My wife, Jessica, and myself at Rio Lagartos in Winter 2017. Could it 

be archaea that cause the pinkish hue?  



better appreciation for a sorely underrepresented domain, and avenues for improving and adapting to an ever-

changing world. 

  



Introduction 

 

What causes the waters adjacent to Rio Lagartos to be pink? Is it because of chemicals added to the water for 

salt purification? Or could it be the brine shrimp that the flamingos feed upon? Or is there something 

microscopic lurking past our field of view? At time of publication, there appears no empirical evidence 

supporting one versus the other. Students will, therefore, design an experiment to identify the organisms in the 

water.* 

 

 

Archaea is one of the few remaining organisms on this Earth that significant discoveries 

can be made at the bench by a high school student.  --- Dr. Julie Maupin-Furlow 

 

 

Just like archaea is relatively new to the scientific community, so is the use of archaea within the classroom. 

Students will ultimately operate off the hypothesis that the archaeal halophile Haloferax volcanii is the culprit. 

The lessons presented can be carried out in either a sequential, interdisciplinary format or (and likely more 

effectively) as an overarching theme for an AP Biology course that continuously gets revisited through each 

discrete unit. H. volcanii will lead students on a journey through its unique (and, in some cases, conserved) 

biochemical requirements, its evolutionary relatedness to the other domains, its ecological impacts, and its 

industrial potential for human society. Along the way, students will hear about new applications, discuss the 

significance and relevance of archaea, model proteins, and analyze genuine scientific data. 

 

After engaging in this lesson, students will hopefully experience a similar moment of shock and excitement that 

Woese had when he first observed archaeal rRNA while working at the University of Illinois at Urbana-

Champaign.  

 

 
Plated cultures of H. volcanii H26. 

Morphologically, the species is reddish-pink 

due to the high levels of carotenoids in its 

membrane. 

 

*Because carrying out the experiment can find 

itself exceeding the scope and available time for 

a traditional AP Biology curriculum, in the 

extension portion of this lesson, students may 

have the opportunity to answer that question.  

 



 

 

Curriculum Tips 

 

Lesson Plan Format:  

All lessons in this curriculum unit are formatted in the same manner. In each lesson, you will find the following 

components: 

 

Lesson Summary: Overview the content addressed and the student learning outcomes. 

Standards: List of specific benchmarks codes addressed in the lesson according to three agencies: Next 

 

nowledge statements (EK).  

Key Question(s): Identifies the questions students should be able to answer following the lesson. 

Learning Objectives: Focuses on what students will know, feel, or be able to do at the conclusion of the lesson. 

Overall Time Estimate: Estimated time needed to accomplish the lesson in class with advanced preparation 

considerations addressed separately. 

Materials: Items and quantities needed to complete the lesson. 

Background Information: Provides accurate, up-to-date information from reliable sources about the lesson 

topic.  

Required Student Background Knowledge: Knowledge students should have or information that should be 

presented prior to beginning the lesson.  

Advanced Preparation: Explains what needs to be done to get ready for the lesson. 

Vocabulary: Key words necessary for comprehension and accomplishing learning objectives. Collected together 

in a glossary at the end of the lesson. 

Procedure and Discussion Questions with Time Estimates: The procedure details the steps of implementation 

with suggested time estimates. The times will likely vary depending on the class. 

Assessment Suggestions: Formative assessment suggestions have been given. Teachers should feel free to create 

additional formative and summative assessment pieces as necessary 

Modifications or Extensions: There are many activities and reading sources available to augment and enhance 

the curriculum, especially those endorsed by or aligned to the AP Biology curriculum. 



Resources / References: Complete citations of references and resources used to design the lesson are included in 

APA style. Additional resources, most often in the form of YouTube videos, are provided with embedded links. 

Teacher Masters: Versions of the student pages with answers or the activity materials for preparation.  



Lesson Summaries 

 

 

Lesson One: Pretty and Pink 

Why are the waters of Rio Lagartos pink? Students will design an experiment to answer the question, learn about 

archaea and chemical functional groups through lecture, read a scientific magazine article about the wonders of 

Archaea, and will compare skeletal structures between the three domains of life.  

 

Lesson Two: Keeping Active 

What is it about active sites of enzymes that allow them to catalyze chemical reactions? Students will be shown how 

research into enzymatic function is important for various industries, especially health. Students will explore the 

relationship of structure and function through a hands-on manipulative activity of substrates and active sites. They will 

deepen their knowledge by investigating the chemical interactions of amino acid side chains with substrates. Lastly, 

they will connect their understanding of structure to function by analyzing how enzyme activity is quantified and 

 

 

Lesson Three: Finding Similarities 

Some gold standards for measuring evolutionary relatedness is looking at nucleotide and amino acid sequence 

alignments. This lesson reveals another method of showing evolutionary relatedness --- protein structure alignment. 

Students will BLAST nucleotide and amino acid sequences for the inorganic pyrophosphatase (PPA) of five species: H. 

volcanii, P. furiosus, E. coli, S. cerevisiae, and H. sapiens. After measuring evolutionary relatedness, they will spend an 

additional day modeling 3D protein structures of PPA in each species and level of similarity between each. 

 

 

 

 

SUBJECT: Advanced Placement (AP) Biology, Biotechnology, Genetics 

GRADE LEVEL/ABILITY: HS 9-12, Honors/AP 

  



Lesson Sequencing Guide 

 

Two lesson sequences are presented for this unit: 

 

1. Continuous: Carrying out each lesson continuously in sequence would be beneficial by providing students 

with a primer for evolutionary biology and ecology if using the Small-to-Big  method or for an ecological 

review and evolutionary primer in the big-small-big method. 

a. Small-to-Big  method involves starting with biochemistry and proceeding to ecology. 

b. Big-small-big  method involves starting with ecology, proceeding to biochemistry, before building 

up again to macrobiology. 

2. Thematically Discontinuous: Carrying out each lesson as an extension for each content area would be 

beneficial as the lessons each are complex and analytical in nature.  

a. This method is likely the most effective implementation of this lesson, using archaea as a theme for 

major units, such as ecology, evolution, and biochemistry independently. 

b. Students would require background knowledge in most instances before being able to adequately 

perform the lessons, so using them as thematic capstones would provide students with the best 

opportunity for learning. 

 

 

Biochemistry                Evolution 

Day 1 Day 2  Day 3 Day 4 
  

Lesson 1 

Pretty & Pink 

 

 

Introducing the 

archaeal domain and 

comparing 

biochemical 

structures of 

membranes 

 

 

 

Lesson 2 

Keeping Active 

 

 

Exploring the 

relationship of 

structure and 

function of enzymes 

with an evolutionarily 

conserved protein 

 

 

   

Lesson 3 

Finding Similarities 

Sequence Homology 

 

Comparing the 

evolutionary 

relatedness using 

DNA and amino acid 

sequences of PPA 

 

 

 

 

Lesson 3 (cont.) 

Finding Similarities 

3D Structure 

 

Comparing 

evolutionary 

relatedness of 

proteins at the 3D 

structural level of 

PPA 

 

 



50 minutes 50 minutes  50 minutes 50 minutes  

 

 

Future Considerations and Extensions 

 

Later in this lesson plan, Haloferax volcanii will be presented as a model archaeon for scientific research. 

Similarly, it can serve as a model organism for an entire year of Advanced Placement Biology. The potential for 

H. volcanii to be used thematically in the course has not escaped my notice, and some ideas for development and 

extension are proposed below. 
 

Future Considerations 

Biochemistry                Ecology 

Lesson 1   Lesson 1  
  

Pumping Ion 

 

 

Analyzing how 

archaeal halophiles 

manage high salt 

environments 

compared to other 

species.  

 

50 minutes 

 
   

So Salty 

 

 

Relating the role of 

archaea in nutrient 

cycles and connecting 

cycle disturbances 

with climate change. 

 

 

50 minutes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Extensions 

Biotechnology 

Lesson 1 Lesson 2 Lesson 3 Lesson 4 
  

Microscopy & 

Culturing 

 

Students will attempt 

to culture H. volcanii 

from an unknown 

sample and via it 

under a microscope. 

 

 

 

Multi-day 

 

Identification 

 

 

Using archaeal 

primers, utilize PCR 

and electrophoresis to 

identify archaeal 

species in the sample. 

 

 

 

Multi-day  

  

UV Mutagenesis 

 

 

Identify growth 

phases using 

spectrometry and 

perform UV 

mutagenesis assay on 

known cultures. 

 

 

50 minutes 

 

Gene Knockouts 

 

 

Using transposon 

mutagenesis, 

auxotroph mutants, 

and other selectable 

markers, attempt 

gene identification. 

 

 

Multi-day  

 

 

 

 

 

Vocabulary  

Critical terms for content understanding (A-P) 

 

Acidic: Side chains that contain carboxylic acid functional groups that are protonated and can donate protons at 

neutral pH (in other words, they have a low pKa). They are extremely hydrophilic. Side chains that are acidic 

include glutamic acid and aspartic acid. 

Active site: Location on an enzyme where catalysis of chemical reactions occurs and is mediated by constituent 

amino acid residues (most often their side chains) within the active site. 

Activity: A measure of an enzymes ability to catalyze reactions. 

Amino acid: Monomeric building block of proteins consisting of an N-terminal amine group, a C-terminal 

carboxylic acid group, and a side chain that carries its own unique chemical properties. 



Archaea: One of the three domains of life discovered in 1977 by Carl Woese & George Fox that differs from bacteria 

and eukaryotes predominantly because of its ribosomal RNA (rRNA). Other differences include membrane structure, 

gene structure, and metabolic pathways. They are also known as archaeabacteria or archaeon when referring to a single 

cell. 

BLAST: Basic Local Alignment Search Tool, a tool using computer algorithms to regions of similarity among 

nucleotide or amino acid sequences. 

Cladogram: Graphical representation of evolutionary relatedness among species. 

Domain: Highest taxonomic division distinguished by similarities in rRNA including archaea, eukarya, and bacteria as 

the three major branches on the tree of life. 

Enzyme: A biological macromolecule that speeds of chemical reactions, consisting primarily of proteins, but 

also inclusive of RNA molecules. 

Functional group: Subunit of a molecule that has distinct chemical properties. 

Homology: Measure of the relatedness or similarity between two items, such as nucleotide sequences, physical 

structures, proteins, amino acid sequences, etc. 

Hydrophilic: Water-loving chemical functional groups because of the polar nature of their bonds and/or their 

ability to form hydrogen bonds with water molecules. Side chains of amino acids that are hydrophilic include 

serine, threonine, asparagine, and glutamine. 

PDB: Protein Data Bank, the repository by the National Center for Biotechnology Information, with structures 

and information of known proteins. 

 

 

 

 

 

 

 



Vocabulary  

Critical terms for content understanding (P-Z) 

 

Phylogenetic tree: Graphical representation of evolutionary relatedness among species, similar to a cladogram, 

but contains more information about the degree of change and time needed for the change to occur. 

pI: The isoelectric point of a protein at which a molecule carries no net electrical charge and is based on the 

chemical nature of functional groups on amino acid side chains and related modifications. Important in 

determining the functionality of proteins in specific aqueous environments. 

Protein: Macromolecule responsible for numerous functions in living organisms, including enzymes and 

providing structure, that are comprised of amino acid monomers. 

Pyrophosphatase: An enzyme responsible for catalyzing the breakdown of pyrophosphate (PPi) into two 

inorganic phosphate ions. The reaction releases a significant amount of energy (-19 kJ/mol free energy change). 

Because it is often coupled with endergonic, or energy-requiring, reactions like DNA synthesis, it is highly 

conserved. 

RMSD: Root mean square difference is a statistical function that calculates the distances of amino acid residues 

between two superimposed structures. The function provides a numerical output that is interpreted as the 

confidence in structural alignment. The lower the value, the more aligned the two structures are. Values <2.000 

indicate strong alignment.  

Side chains: The functional group attached to the alpha-

chemical properties. Denoted by the letter R  in amino acid diagrams. 

Tree of life: Model illustrating the relationship of organisms beginning with the origin of life Earth and branching out 

from the last universal common ancestor. 

 

  



Standards 

 

AP Biology Curriculum Framework: Essential Knowledge Statements 

Standard 
Lesson 

1 2 3 4 

E.K.1.B.1 

Organisms share many conserved core processes and features that 

evolved and are widely distributed among organisms today. 

    

E.K.1.B.2 

Phylogenetic trees and cladograms are graphical representations 

(models) of evolutionary history that can be tested. 

    

E.K.2.B.1 

Cell membranes are selectively permeable due to their structure. 
    

E.K.4.A.1 

The subcomponents of biological molecules and their sequence 

determine the properties of that molecule.  

    

E.K.4.B.1 

Interactions between molecules affect their structure and function. 
    

 

AP Biology Curriculum Framework: Science Practices 

Standard 
Lesson 

1 2 3 4 

Science Practice 1 

The student can use representations and models to communicate 

scientific phenomena and solve scientific problems.  

    

Science Practice 3 

The student can engage in scientific questioning to extend thinking or 

to guide investigations within the context of the AP course.  

    

 



Standards 

 

Next Generation State Standards 

Standard 
Lesson 

1 2 3 4 

HS-LS1-1 From Molecules to Organisms: Structures and Processes 

Construct an explanation based on evidence for how the structure of 

DNA determines the structure of proteins which carry out the 

essential functions of life through systems of specialized cells. 

    

HS-LS1-2 From Molecules to Organisms: Structures and Processes 

Develop and use a model to illustrate the hierarchical organization of 

interacting systems that provide specific functions within multicellular 

organisms. 

    

HS-LS1-6 From Molecules to Organisms: Structures and Processes 

Construct and revise an explanation based on evidence for how 

carbon, hydrogen, and oxygen from sugar molecules may combine 

with other elements to form amino acids and/or other large carbon-

based molecules. 

    

HS-LS4-1 Biological Evolution: Unity and Diversity 

Communicate scientific information that common ancestry and 

biological evolution are supported by multiple lines of empirical 

evidence. 

    

 

 

 

 

 

 

 

 

 

 

 

 



Next Generation Sunshine State Standards 

Standard 
Lesson 

1 2 3 4 

SC.912.N.1.1 

Define a problem based on a specific body of knowledge, for example: 

 

    

SC.912.N.3.5 

Describe the function of models in science, and identify the wide range of 

models used in science.  

    

SC.912.L.14.3 

Compare and contrast the general structures of plant and animal cells. 

Compare and contrast the general structures of prokaryotic and eukaryotic 

cells. 

    

SC.912.L.15.4  

Describe how and why organisms are hierarchically classified and based on 

evolutionary relationships. 

    

SC.912.L.15.6 

Discuss distinguishing characteristics of the domains and kingdoms of living 

organisms. 

    

SC.912.L.16.10 

Evaluate the impact of biotechnology on the individual, society and the 

environment, including medical and ethical issues. 

    

SC.912.L.18.1 

Describe the basic molecular structures and primary functions of the four 

major categories of biological macromolecules. 

    

SC.912.L.18.4 

Describe the structures of proteins and amino acids. Explain the functions of 

proteins in living organisms. Identify some reactions that amino acids 

undergo. Relate the structure and function of enzymes. 

    

SC.912.L.18.11 

Explain the role of enzymes as catalysts that lower the activation energy of 

biochemical reactions. Identify factors, such as pH and temperature, and 

their effect on enzyme activity. 

    



Background 

 

Life is described according to two general distinctions: those without nuclei (prokaryotes) and those with 

nucleic (eukaryotes). Up until 1977, it was believed that prokaryotes consisted only of bacteria. Carl Woese 

revolutionized our understanding of taxonomy when a colleague provided him with a microorganism that was 

unlike any Woese had sequenced previously. Using ribosomal RNA as a basis of evolutionary relatedness, he 

subdivided prokaryotes into eubacteria (true bacteria) and archaeabacteria. Now, rather than kingdoms being 

the highest taxonomic level, it has since been replaced with three domains: archaea, bacteria, and eukarya. 

 

Archaea are believed to be evolutionary relics of life on Earth. Structurally speaking, their ribosomal RNA 

shares greater similarities to eukaryotes than bacteria. Archaeal RNA polymerases also follow the same trend. 

Archaea have an unusual lipid structure composed of isoprenoid polymers rather than fatty acids and are 

attached via ether bonds (instead of esters) to phosphoglycerol. Some archaeal species have monolayer 

membranes, while others have bilayers. Metabolically, many prefer conditions resembling early Earth and are 

found in some of the most extreme environments; however, more research is showing that archaea are more 

abundant worldwide than previously thought. Up until the last thirty years, an entire domain of life was outside 

the purview of scientists because of their unique habitats and lack of pathogenesis.  Consequently, archaea are 

believed to have had little pressure to change from their original niches, which is one explanation for why there 

are no known pathogenic archaeal species (Schaechter, Ingraham, & Neidhart, 2006).  

 

The best studied phyla of archaea are Crenarchaeota (thermoacidophiles) and Euryarchaeota (halophiles and 

methanogens). There are numerous other phyla presented, including Korarchaeota, Nanoarchaeota, and the 

Asgardian archaeaota (Lokiarchaeota, Thorarchaeota, Odinarchaeota, and Heimdallarchaeota). The other phyla 

are less-well studied due to their extremophilic nature and the subsequent difficulty in culturing them. Below 

are some of the qualifications to be extremophiles, adapted from Schaechter, Ingraham, & Neidhart (2006) and 

Oren (2002). 

 

Class Typically grows at: 

Thermophile >50°C 

Extreme thermophile >70°C 

Acidophile pH<3.0 

Halophile >100 g/L salt 

Barophile >40MPa 

Psychrophile 5°C 



 

The archaea utilized as a model in these lessons, Haloferax volcanii, is a halophile. According to Oren (2002), 

halophiles exist in all three domains. Many halophiles are also photosynthetic even in the highest of salt 

concentrations, especially bacteria and eukaryotes. One genus of eukaryotes is a green alga called Dunaliella. D. 

salina and D. bardawil diverge from the typically green appearance because both contain large amounts of beta 

carotene, which give the characteristic red colors found in certain salterns. There is also a species of fungus that 

prefers growing in high salt environments, and despite occasionally being a contaminant in halophile cultures, it 

has not been well-studied. 

 

Haloferax volcanii is facultative aerobe widely considered to be a model archaeon because of its mesophilic 

temperature preferences (42°C), ability to be cultured, nonpathogenic nature, and resistance to contamination 

because of its halophilic requirements (21% NaCl). The organism was discovered in 1940 by Bernard Volcani 

during his studies of the Dead Sea, but was first presented as a species by Mullakhanbhai & Larsen in 1975. 

The requirements for growth are minimal, many of which are even found on grocery store shelves: NaCl (table 

salt), MgSO4 · 7H2O (Epsom salt), MgCl2 · 6H2O, KCl (Nu-Salt), CaCl2 · 2H2O (antacid), agar, yeast extract, 

and tryptone (Kouassi, Waldron, Tripepi, & Pohlschroder, 2017). It grows optimally in salt concentrations 

greater than 2M NaCl at 45°C with a doubling time every 4 hours. In liquid cultures, H. volcanii appears a pale, 

yellowish-pink, and on solid media, it bears the color as observed in the Introduction of this lesson. It respires 

preferentially on glycerol, especially the remains of Dunaliella after seasonal increase in salt concentration causes 

the eukaryotes to lyse. It preferentially grows with oxygen as a terminal electron acceptor, but in anoxic 

conditions, it can act as a denitrifier. In terms of its genome, it the DS2 (Dead Sea 2) strain was fully sequenced 

in 2010 (Hartman et al., 2010).  Four years later, a comprehensive transposon insertion mutant library was 

created in order to aid gene discovery (Kiljunen et al., 2014). Extensions to this lesson are quite evident due to 

the growing understanding of H. volcaniiUnlike many halophiles who use a salt-out strategy, where they pump 

salt out of their cells and maintain osmostasis through the production of organic solutes (like glycerol in the case 

of D. salina), H. volcanii maintains osmostasis by pumping KCl into the cell balance the high salt concentration 

in the external environment. These mechanisms are addressed in a lesson regarding osmolarity. 

 

Another mechanism addressed as a lesson is the research completed by the Maupin-Furlow Lab on inorganic 

pyrophosphatase in H. volcanii (HvPPA). PPA is an enzyme found abundantly in living organisms and assumes 

the role of hydrolyzing inorganic pyrophosphate (PPi) to two inorganic phosphate ions (Pi). While ATP can be 

broken down into ADP, other reactions occur where ATP is broken down directly into AMP with PPi as an 

additional product. Hydrolysis of pyrophosphate is highly exergonic (energy-releasing) and is therefore coupled 

with other endergonic reactions (energy requiring) such as DNA synthesis or the formation of other 

macromolecules. Pyrophosphate can be concern in biotechnology as a contaminant and its breakdown can lead 



to the supply of energy for unintended side reactions. Furthermore, according to Heikinheimo et al. (1996), 

high levels of inorganic pyrophosphate can be toxic to the cell, thus emphasizin  need for it. 

  



Lesson 1: Pretty and Pink 

Introduction to Archaea  

 

LESSON SUMMARY:  

Why are the waters of Rio Lagartos pink? Students will design an experiment to answer the question, learn about 

archaea and chemical functional groups through lecture, read a scientific magazine article about the wonders of 

Archaea, and will compare skeletal structures between the three domains of life.  

 

STANDARDS: 

AP Biology NGSS NGSSS 

E.K.2.B.1 HS-LS1-2 SC.912.N.1.1 

E.K.4.A.1 HS-LS1-6 SC.912.L.14.3 

E.K.4.B.1  SC.912.L.15.6 

Science Practice 1  SC.912.L.18.1 

Science Practice 3   

 

KEY QUESTION(S):   

What are archaea? 

How do they relate to bacteria and eukaryotes? 

 

LEARNING OBJECTIVES: 

The student will be able to... 

 

1.Define and identify functional groups in biochemical molecules. 

2. Describe archaea. 

3. Explain the similarities and differences between archaea, bacteria, and eukarya.   

 

OVERALL TIME ESTIMATE:   

Advanced Preparation: 20 minutes to read and assemble Scientific American articles, laminate the membrane molecules, 

and print Experimental Design Graphic Organizer and Membrane Comparison Activity sheets. 

Lesson: 50 minutes 

 

MATERIALS:   

Essential 

Experimental Design Graphic Organizer (1 per group of 4) 



Membrane Comparison Activity (1 sheet and 1 set of 9 molecules per group of 4) 

Scientific American article titled, Archaea are more wonderful than you know  (1 for each student; electronic access 

would save paper) 

7 colored vis-à-vis markers (blue, red, green, yellow, purple, orange, black) (1 set per group of 4) 

 

BACKGROUND INFORMATION:  

Ria Lagartos Biosphere Reserve, or Rio Lagartos, is a UNESCO biosphere reserve in Yucatan, Mexico. Translated in 

English to lizard river,  it was named by Spanish conquistador Francisco Hernandez because of the numerous 

crocodiles he saw during an expedition

for the unique coloration of its waters. Las Coloradas are lakes within the biosphere that are strikingly pink. 

Explanations about its coloration range from the presence of brine shrimp (and the pink flamingos frequenting there), 

chemicals in the water for purification of the salts, or, as hypothesized for this lesson, archaebacteria. 

 

In 1977, Carl Woese was approached by a fellow researcher with a microorganism that he wanted Woese to identify. 

Using a new sequencing method he developed for ribosomal RNA, he noticed that it was unlike any bacteria he had 

seen before --- thus, the three-domain system was born. Archaea are distinct from other prokaryotes and eukaryotes 

because of its rRNA sequence; it actually is more closely related in structure to eukaryotes than bacteria. Furthermore, 

their membranes have unique structures made of ether linkages between lipids and glycerol molecules rather than ester 

linkages found in the other domains. The membranes can be bilayers or in some cases monolayers, with opposite layers 

chemically bonded together. The nature of these linkages is believed to be less reactive than ester-linkages and also 

 

simple, linear chains. Their subunits are actually isoprene ( ) polymers. Speaking of extreme environments, likely 

cannot tolerate, such as anaerobic regions, deep sea thermal vents, or acidic bodies of water; however, in recent years, 

archaea are found to be more ubiquitous in moderate locals than previously thought. Additionally, because no archaea 

have been known to cause disease, they have managed to stay out of the human eye for much longer than expected.   

 

Functional groups are the subunits responsible for chemical reactivity in a molecule. The AP Biology Curriculum 

Framework includes a learning objective specifically mentioning the use of models to predict and justify how changes in 

structure affect the function (Learning Objective 4.3). While specific molecular structures of macromolecules are 

beyond the scope of the curriculum, teachers would be remiss not to facilitate recognition of important molecular 

components and connect it to function. Furthermore, understanding membrane composition is key to understanding 

their semipermeable nature and how they help to suit specific organisms to their environments (especially in the case of 

archaea). 



 

REQUIRED STUDENT BACKGROUND KNOWLEDGE: 

Students should have previously covered the structural and chemical differences of the four main classes of 

macromolecules: lipids, carbohydrates, proteins, and nucleic acids. This lesson serves as an extension to that concept by 

justifying how macromolecules are used to distinguish between different forms of life. 

 

Students should also have prior knowledge of the components to experimental design: hypothesis, variables 

(independent, dependent, and controlled), control versus experimental groups, and expectations on data collection. 

 

Background knowledge on cell structure, specifically members are beneficial. Most students in an AP Biology 

classroom should have had prior background experience that cellular membranes are phospholipids (phosphate head 

connected to a lipid), but a refresher on this fact might be helpful. 

 

ADVANCED PREPARATION:   

For reusability, it would be helpful to laminate the membrane molecules ahead of time. Students could then annotate 

the laminations with vis-à-vis markers, and wash it off when finished. Otherwise, printing separate sets each time 

would allow the students to write on them and keep them for future review. Place the sets equally throughout the 

classroom (preferably on lab benches) with 7 vis-à-vis marker colors provided: blue, red, orange, purple, green, yellow, 

and black. 

 

Print copies for the Experimental Design Graphic Organizer and Membrane Comparison Activity (1 per group of 4).  

 

The Scientific American article can be given as a handout or digitally. If given as a handout, 1 copy per student is 

needed; otherwise, provide a link or a PDF version of the article students if providing digitally. Also, make sure the 

article link is still valid and accessible via the medium you wish to use. The accompanying questions can be assembled 

into a handout, displayed via projector, or written on the whiteboard. If choosing either of the latter, have students take 

out a sheet of paper to jot their answers down in order to facilitate discussion.  

 

VOCABULARY:  

Archaea: One of the three domains of life discovered in 1977 by Carl Woese & George Fox that differs from bacteria 

and eukaryotes predominantly because of its ribosomal RNA (rRNA). Other differences include membrane structure, 

gene structure,  andmetabolic pathways. They are also known as archaeabacteria or archaeon when referring to a single 

cell. 



Tree of life: Model illustrating the relationship of organisms beginning with the origin of life Earth and branching out 

from the last universal common ancestor. 

Domain: Highest taxonomic division distinguished by similarities in rRNA including archaea, eukarya, and bacteria as 

the three major branches on the tree of life. 

Functional group: Subunit of a molecule that has distinct chemical properties. 

 

PROCEDURE AND DISCUSSION QUESTIONS WITH TIME ESTIMATES:   

Why Is It Pink? (15 --- 20 minutes) 

1. Hook the students by displaying the slide with the pictures of Rio Lagartos from the Expert Vagabond blog and/or 

personal images. If the teacher has been to any high saline lakes, such as Great Salt Lake, the Dead Sea, or others, 

providing personal experience will greatly help increase engagement. 

2. As the images are shown, ask the students, Why is it pink?  Elicit feedback and possible mechanisms about what 

could cause the coloration. List them on a whiteboard. 

3. Arrange the students in groups of 4 and instruct them to spend 10 minutes designing an experiment to identify 

what causes the colors of the lake.  

a. Students will want to establish a hypothesis before attempting to create methods, and they will want to 

clearly identify variables and experimental groups.  

b. Each group should use the Experimental Design Graphic Organizer to help organize their plan.  

c. Move around the room to field questions as necessary and/or to give further details needed to refine their 

study.  

d. 

collect the graphic organizers for later assessment. 

 

What Are Archaea? (10 --- 15 minutes) [POTENTIAL MODIFICATION] 

1. Transition the students to reading the Scientific American article titled, Archaea are more wonderful than you 

know.  

a. Students may stay in their groups to facilitate the next activity and intragroup discussion, or they can return 

to their seats to read independently. 

b. If using handouts, distribute one to each student and encourage them to mark it up as they read.  

c. If using digital versions, ensure the students have access to the link and their devices are functioning prior to 

the start of this segment. 

2. Provide the students with the questions ahead of time, either through a handout or via overhead display. Allow the 

students to read the article, then discuss the answers to the questions below.  

https://expertvagabond.com/las-coloradas-pink-lake/


 Why is it difficult to distinguish bacteria species from animal species? 

 When did Carl Woese discover the new domain, archaea? 

 What ultimately distinguishes the three domains of life? 

 How are archaea similar to Us ? 

 How are archaea dissimilar to bacteria? 

 Identify 1-  

  

 Make a prediction about archaea that we will eventually discover in the future and justify your claim. 

3. MODIFICATION: If time is a concern, have the students read the article ahead of time and prepare their answers 

for discussion during class. This component may also be used as an online discussion, but would likely be best 

suited for in-class discussion prior to the start of the Membrane Comparison Activity. 

 

 

Membrane Comparison Activity (15 --- 20 minutes) 

1. Arrange the students again into groups of four if they were working independently. Direct them to tables or 

benches where the laminated cutouts and markers are already placed for the Membrane Comparison Activity. 

2. Students will do the following with the cutouts: 

a. Circle functional groups with specific colors according to the handout. 

b. Identify intermolecular force potential (FON elements can hydrogen bond, polar molecules form dipole 

interactions, and C-H structures [and all others] can form dispersion forces] 

c. Identify which type of molecules can pass through the portion of the structure: hydrophobic or hydrophilic. 

3. Once they finish the annotation segment, students will then want to identify which molecule belongs to which 

domain based on their readings and prior knowledge of cellular membranes of eukaryotes and bacteria. 

a. Students should provide a brief set of reasoning, such as ester bonds = eukaryotes/bacteria  to justify their 

position. 

4. The remaining time should be spent answering the extension questions. Encourage group discussion and 

collaboration. If there is not enough time remaining, have students complete this for homework. Because it is a 

group assignment, encourage students to take pictures with their phones if they need to complete it for homework. 

a. Tip: Encourage students to utilize prefixes and suffixes to help them understand structures. For example, 

phospholipids should have phosphates and lipids in them. Glycerol ( ) is why the lipid test you have 

triglycerides (three fatty-acid chains on one glycerol). Cholesterols are found only in 

the eukaryotic domain, and lipopolysaccharides (lipids attached to multiple sugars) are the endotoxic 

component of gram-negative bacteria. Students will certainly be exposed to vocabulary on the AP exam that 

they will have never heard before, so encouraging them to practice morphemic analysis will greatly help their 

comprehension later in the year. 



 

ASSESSMENT SUGGESTIONS:   

Experimental Design 

group or need more time for more detailed observation, collect their designs. Verbalize and/or annotate possible 

revisions as experimental design is a key understanding requirement for any science course. 

 

Membrane Comparison Activity 

Collect the completed handout and compare to the teacher master copy.  

Engage in discussion on extensions questions, asking students to provide answers and to defend their points of view 

with evidence provided from the article and from the molecule activity.  

 

MODIFICATIONS or EXTENSIONS: 

Based on students reading skills, the article may be assigned as a homework assignment prior to the start of the 

lesson. It would save approximately 10 minutes of time that could be transferred to the Membrane Comparison 

Activity, especially because students will likely have greater difficulty with that section of the lesson than the 

article. 

  

Students may be able to carry their design experiments with help from individuals residing in Rio Lagartos, 

individually created samples comprised of brine shrimp and Haloferax volcanii cultures (ATCC29605), or by 

receiving samples from archaea researchers. There are previously designed lessons involving culturing and 

biotechnology work involving archaeal halophiles by Dassarma et. al (2016) and Kouassi, Waldron, Tripepi, & 

Pohlschroder (2017). 

 

RESOURCES/REFERENCES:  

Dassarma, P., Tuel, K., Nierenberg, S. D., Phillips, T., Pecher, W. T., Dassarma, S. (2016). Inquiry-driven 

teaching & learning using the archaeal microorganisms Halobacterium NRC-1. American Biology Teacher, 

78(1), 7-13. 

Frazer, J. (2013). Archaea are more wonderful than you know. Scientific American. Retrieved from 

https://blogs.scientificamerican.com/artful-amoeba/archaea-are-more-wonderful-than-you-know/ 

Gribaldo, S., & Brochier-Armanet, C. (2006). The origin and evolution of Archaea: a state of the art. 

Philosophical Transactions of the Royal Society B: Biological Sciences, 361(1470), 1007---1022 

Jain, S., Caforio, A., & Driessen, A. J. M. (2014) Biosynthesis of archaeal membrane ether lipids. Frontiers in 

Microbiology, 5, 1 --- 15. doi: 10.3389/fmicb.2014.00641 

https://www.atcc.org/products/all/29605.aspx


Karsten, M. (2016). The unbelievable pink lakes of Las Coloradas in Mexico. Expert Vagabond. Retrieved from 

https://expertvagabond.com/las-coloradas-pink-lake 

Kouassi, J. E., Waldron, I., Tripepi, M., & Pohlschroder, M. (2017). Laboratory activity to promote student 

understanding of UV mutagenesis & DNA repair. Journal of Microbiology & Biology Education, 18(1), 1-

3. doi: 10.1128/jmbe.v18i1.1202 

Woese, C. R., & Fox, G. E. (1977). Phylogenetic structure of the prokaryotic domain: the primary kingdoms. 

PNAS, 74(11), 5088---5090 

 

Articles & Photos 

 Archaea are more wonderful than you know,  Scientific American: https://blogs.scientificamerican.com/artful-

amoeba/archaea-are-more-wonderful-than-you-know/?print=true 

 The unbelievable pink lakes of Las Coloradas in Mexico,  Expert Vagabond: https://expertvagabond.com/las-

coloradas-pink-lake 

 

Supplemental Videos 

 Bozeman Science --- Biological Molecules 

 Crash Course --- Biological Molecules: You Are What You Eat 

 Crash Course --- In Da Club: Membranes & Transport 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.bozemanscience.com/042-biologoical-molecules/
https://www.youtube.com/watch?v=H8WJ2KENlK0
https://www.youtube.com/watch?v=H8WJ2KENlK0
https://www.youtube.com/watch?v=H8WJ2KENlK0
https://www.youtube.com/watch?v=H8WJ2KENlK0


Experimental Design Graphic Organizer 
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Problem or Question 

Identify the knowledge gap or reason for conducting research on this topic. 

 

Background Information 

Provide key information about the knowledge gap exists and why there needs to be research on this topic. 

 

Hypothesis 

Identify the expected outcome of your investigation what you hope to discover or accomplish. 
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Independent Variable(s) 

Identify what you are manipulating and how it can be quantified. 

 

Dependent Variable(s) 

Identify what you are measuring and how it can be quantified. 

 

Other Variables 

Identify the other variables that could impact the outcome of the experiment and what value you will hold them constant. 

 

Methods 

Describe your methods concisely in key bullet points, being specific to what is being manipulated, measured, and recorded. Identify control group and 

experimental groups. 

Materials 

Identify important materials and equipment necessary to accomplish your methods. 

R
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Data Organization 

Describe how you intend on recording your data (usually a data table or spreadsheet) and how you intend on graphically representing it 

 

 



 

Experimental Design Graphic Organizer 
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Problem or Question 

Identify the knowledge gap or reason for conducting research on this topic. 

What is causing the water of Las Coloradas to turn pink? 

Background Information 

Provide key information about the knowledge gap exists and why there needs to be research on this topic. 

Brine shrimp are pink in large populations and are the cause of flamingos pink-colored feathers. 

Haloferax volcanii are pink when cultured in high salt concentrations. 

Potassium permanganate is rumored to be responsible for purifying the salterns and has a 

pinkish/purple color. 

Algae high in carotenoids can appear reddish/pinkish in color depending on the size of the 

population. 

Hypothesis 

Identify the expected outcome of your investigation what you hope to discover or accomplish. 

H. volcanii and/or other halophilic archaeal species are causing the pink color. 
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Independent Variable(s) 

Identify what you are manipulating and how it can be quantified. 

Species of organisms being cultured. 

Dependent Variable(s) 

Identify what you are measuring and how it can be quantified. 

Qualitative coloration and presence of H. volcanii on plates.  

Other Variables 

Identify the other variables that could impact the outcome of the experiment and what value you will hold them constant. 

Subculture nutrients (according to Kouassi, Waldron, Tripepi, & Pohlschroder (2017).) 

Temperature (42°C) 

Salt concentration according to growth protocol (2.5 --- 5M) 

Methods 

Describe your methods concisely in key bullet points, being specific to what is being manipulated, measured, and recorded. Identify control group and 

experimental groups. 

Prepare growth media according to plan listed above. 

Transfer portion of sample to growth media and incubate for 5-7 days. 

Control Groups: + control for H. volcanii, - control (no culture) 

Experimental Groups: 5 plates of cultured sample 



Materials 

Identify important materials and equipment necessary to accomplish your methods. 

Nutrient media according to Kouassi, Waldron, Tripepi, & Pohlschroder (2017). 

Sample from Rio Lagartos 

R
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Data Organization 

Describe how you intend on recording your data (usually a data table or spreadsheet) and how you intend on graphically representing it 

Growth as a +/- 

Coloration as a +/- 

 

If culture fails, attempt with other culturing methods for other species. 
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Membrane Comparison Activity 

 

Circle the following functional groups on each molecule using the colors indicated below. Also, indicate the 

intermolecular force (IMF) potential and identify which type of molecules (hydrophobic/hydrophilic) could pass 

through regions containing these groups.   

Functional Group Color IMF Potential 
Ability to Pass 

Hydrophobic/Hydrophilic 

Ether Blue   

Ester Red   

Phosphate Purple   

Amine Green   

Hydrocarbon Chain  

(~>5 carbons) 
Yellow   

Unsaturated Bond Black   

Hydroxyl Group Orange   

 

Identify the domain that each membrane component corresponds to (some can have more than one) and provide a 

brief justification why. 

Molecule Domain Reasoning 

1   

2   

3   

4   

5   

6   

7   

8   

9   

 

Extension Questions 

The structures for the archaeal lipids in this activity are missing a functional group that should be present in the 

membranes. What is missing? What functional group should they attach to? 

 



 

 

 

Describe the most significant chemical difference between archaeal membranes and other domains of life. 

 

 

Structure determines function. Predict what the difference in lipid structure provides functionally for archaea 

versus bacteria and eukaryotes. 



 

Membrane Comparison Activity 

 

Circle the following functional groups on each molecule using the colors indicated below. Also, indicate the 

intermolecular force (IMF) potential and identify which type of molecules (hydrophobic/hydrophilic) could pass 

through regions containing these groups.   

Functional Group Color IMF Potential 
Ability to Pass 

Hydrophobic/Hydrophilic 

Ether Blue London, Dipole, H Bond Hydrophilic 

Ester Red London, Dipole, H Bond Hydrophilic 

Phosphate Purple London, Dipole, H Bond Hydrophilic 

Amine Green London, Dipole, H Bond Hydrophilic 

Hydrocarbon Chain  

(~>5 carbons) 
Yellow London Hydrophobic 

Unsaturated Bond Black London Hydrophobic 

Hydroxyl Group Orange London, Dipole, H Bond Hydrophilic 

 

Identify the domain that each membrane component corresponds to (some can have more than one) and provide a 

brief justification why. 

Molecule Domain Reasoning 

1 Archaea Ether linkage to hydrocarbon chain; isoprene chain 

2 Eukarya Cholesterol only found in animals (and modified version in plants) 

3 Archaea Ether linkage to hydrocarbon chain; isoprene chain; monolayer 

4 Eukarya 
Triglycerides are found primarily in eukaryotes (although new 

evidence shows rare presence in bacteria) 

5 Bacteria Lipopolysaccharide layer found in Gram-negative bacteria 

6 Archaea Ether linkage to hydrocarbon chain; isoprene chain; monolayer 

7 Bacteria/Eukarya Ester linkages & phospholipid 

8 Bacteria/Eukarya Ester linkages & phospholipids 

9 Archaea Ether linkage to hydrocarbon chain; isoprene chain; monolayer 

 

Extension Questions 

The structures for the archaeal lipids in this activity are missing a functional group that should be present in the 

membranes. What is missing? What functional group should they attach to? 

Archaeal lipids are missing phosphate groups and they should attach to the free ---OH (hydroxyl) group. 



 
 

Describe the most significant chemical difference between archaeal membranes and other domains of life. 

The biggest chemical difference is the ether bond between the glycerol and the fatty acid in archaea versus esters in 

bacteria and eukarya. The fatty acid chains are also made of isoprenoids rather than simple, linear hydrocarbons. 
 

Structure determines function. Predict what the difference in lipid structure provides functionally for archaea 

versus bacteria and eukaryotes. 

Ethers are less reactive than esters, which would allow archaea to survive in more extreme environments. It 

 



 

Teacher Notes 

Lesson 1: Pretty and Pink --- Introduction to Archaea   

 

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             



 

             

             

             

             

             

             

             

              

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Lesson 2: Keeping Active 

Exploring the active site of inorganic pyrophosphatase  

 

LESSON SUMMARY:  

What is it about active sites of enzymes that allow them to catalyze chemical reactions? Students will be 

shown how research into enzymatic function is important for various industries, especially health. 

Students will explore the relationship of structure and function through a hands-on manipulative activity 

of substrates and active sites. They will deepen their knowledge by investigating the chemical 

interactions of amino acid side chains with substrates. Lastly, they will connect their understanding of 

structure to function by analyzing how enzyme activity is quantified and affected by changes to an 

 

 

STANDARDS: 

AP Biology NGSS NGSSS 

E.K.1.B.1 HS-LS1-2 SC.912.N.3.5 

E.K.4.A.1 HS-LS1-6 SC.912.L.16.10 

E.K.4.B.1  SC.912.L.18.4 

Science Practice 1  SC.912.L.18.11 

 

KEY QUESTION(S):   

How do enzymes catalyze reactions? 

How does protein structure determine its function? 

What are benefits and limitations of models in science? 

 

LEARNING OBJECTIVES: 

The student will be able to... 

 

1. Compare and contrast the change in models over time. 

2. Model and describe how substrates and enzymes interact to catalyze chemical reactions. 

3. Analyze the optimum conditions for enzymatic activity. 

 



 

 

OVERALL TIME ESTIMATE:   

Advanced Preparation: 20 minutes to print copies of the Side Chain Analysis Activity, Enzyme Active 

Site/Substrate Manipulative, and Enzyme Activity Graphical Analysis. The substrates for the 

manipulative should be printed on transparency, and the enzymes should be laminated. Markers or other 

colored utensils should also be placed at stations accompanying the manipulatives. The first page of the 

Enzymatic Activity Graphical Analysis handout should be printed single-sided and potentially 

laminated for student annotations and repeat usability. The data analysis questions should be printed 

double sided. 

Lesson: 50 minutes 

 

MATERIALS:   

Essential 

Set of three colored writing utensils (blue, red, and black) (1 set per group of 4) 

Laminated enzyme active site and printed substrates on transparency paper (1 set per group of 4)  

Side Chain Analysis Activity Handout (1 per group of 4) 

Enzymatic Activity Graphical Analysis Handout (1 per group of 4) 

 

BACKGROUND INFORMATION:  

Proteins are one of the four major classes of organic macromolecules and are comprised of amino acid 

monomers. A reaction between two amino acids results in dehydration (loss of water) between the 

carboxylic group of one amino acid and the amine group of another in order to form a covalent, peptide 

bond. Proteins ultimately have four levels of structure that bestow its function: primary, secondary, 

tertiary, and quaternary structure. Primary structure is the linear amino acid sequence as determined by 

the gene sequence and is held together by covalent, peptide bonds. Secondary structure occurs when the 

carboxylic acid and amine groups hydrogen bond together to form the initial three-dimensional 

structure. The two predominant forms of secondary structure occur: alpha-helices and beta-sheets. 

Tertiary structure occurs when the amino acid side chains begin to exhibit intermolecular attractions 

(also called van der Waals forces), such as London dispersion forces, dipole-dipole interactions, or 

hydrogen bonding. Additionally, tertiary structure occurs through covalent disulfide bridges between 

two cysteine thiol side chains or two amino acids forming salt-bridges due to opposite charge attractions. 

Lastly, quaternary structure occurs when multiple polypeptides attract via intermolecular forces. All told, 



 

the change in conformation (shape) helps to lower the energy and increase stability of the molecule. 

Depending on the structure, proteins can assume various functions including structural or enzymatic 

roles within or outside of the cell. 

 

Enzymes are biological catalysts that are predominantly protein in structure, but can sometimes exist in 

the form of RNA. Enzymes lower the activation energy of chemical reactions, therefore making them 

more thermodynamically and energetically favorable to occur. The primary driver of the lowering of 

increase strain on the bonds of the substrate, thereby making it easier for the reaction to occur. The 

active site is heavily dependent on environmental conditions, such as proper water or salt content, pH 

levels, or temperature. An enzyme can be regulated in numerous ways, either by limiting its production 

(lessening gene expression), competitively inhibiting its active site with another substrate, or modifying 

the shape of its active site via allosteric inhibition.. 

 

Inorganic pyrophosphatase is an enzyme found abundantly in living organisms and assumes the role of 

hydrolyzing inorganic pyrophosphate (PPi) to two inorganic phosphate ions (Pi). Pyrophosphate is often 

present as a product of ATP breakdown into AMP. Hydrolysis of pyrophosphate is highly exergonic 

(energy-releasing) and is therefore coupled with other endergonic reactions (energy requiring) such as 

DNA synthesis or the formation of other macromolecules. Pyrophosphate can be concern in 

biotechnology as a contaminant and its breakdown can lead to the supply of energy for unintended side 

reactions. Furthermore, according to Heikinheimo et al. (1996), high levels of inorganic pyrophosphate 

can be toxic to the cell, thus emphasizing the need for it. Related to this lesson, McMillan, Hewopit, & 

Maupin-Furlow (2016) have elucidated the activity of H. volcanii inorganic pyrophosphatase activity 

under high levels of organic solvent. This lesson helps to set the stage on why understanding protein 

structure is important, especially in unique environments and applications. 

 

REQUIRED STUDENT BACKGROUND KNOWLEDGE: 

Students should be able to recognize the relative structure and reactivity of key functional groups, such 

as amine, hydroxyl, carbonyl, carboxyl, and hydrophobic groups. 



 

Students should enter this activity with prior knowledge of the four levels of protein structure (primary, 

secondary, tertiary, and quaternary) and should be able to describe and model the chemical attractions 

leading to each.  

 

Students should also know the major functions of proteins, especially enzyme function, and be able to 

describe the thermodynamics related to chemical reactions and enzyme activity. 

 

ADVANCE PREPARATION:   

The DNA base substrates should be printed on transparency paper (1 set per group of 4). The two sides 

are mirror images to each other, so cut along the outside border and fold in half at the center. 

Meanwhile, print and laminate the enzyme (1 set per group of 4). Three colored writing untensils (blue, 

red, black) (1 set per group of 4) should be put out at each lab bench along with the manipulatives. 

 

Print copies of the Side Chain Analysis Activity (1 per group of 4). 

 

VOCABULARY:  

Protein: Macromolecule responsible for numerous functions in living organisms, including 

enzymes and providing structure, that are comprised of amino acid monomers. 

Amino acid: Monomeric building block of proteins consisting of an N-terminal amine group, a 

C-terminal carboxylic acid group, and a side chain that carries its own unique chemical 

properties. 

Side chains: The functional group attached to the alpha-carbon of an amino acid that bestows 

R  in amino acid diagrams. 

Acidic: Side chains that contain carboxylic acid functional groups that are protonated and can 

donate protons at neutral pH (in other words, they have a low pKa). They are extremely 

hydrophilic. Side chains that are acidic include glutamic acid and aspartic acid. 

Hydrophilic: Water-loving chemical functional groups because of the polar nature of their bonds 

and/or their ability to form hydrogen bonds with water molecules. Side chains of amino acids 

that are hydrophilic include serine, threonine, asparagine, and glutamine. 



 

pI: The isoelectric point of a protein at which a molecule carries no net electrical charge and is 

based on the chemical nature of functional groups on amino acid side chains and related 

modifications. Important in determining the functionality of proteins in specific aqueous 

environments. 

Enzyme: A biological macromolecule that speeds of chemical reactions, consisting primarily of 

proteins, but also inclusive of RNA molecules. 

Active site: Location on an enzyme where catalysis of chemical reactions occurs and is mediated 

by constituent amino acid residues (most often their side chains) within the active site. 

Activity: A measure of an enzymes ability to catalyze reactions. 

Pyrophosphatase: An enzyme responsible for catalyzing the breakdown of pyrophosphate (PPi) 

into two inorganic phosphate ions. The reaction releases a significant amount of energy (-19 

kJ/mol free energy change). Because it is often coupled with endergonic, or energy-requiring, 

reactions like DNA synthesis, it is highly conserved. 

 

PROCEDURE AND DISCUSSION QUESTIONS WITH TIME 

ESTIMATES:   

Pyrophosphatase Introduction (10 minutes) 

1. Explain that discoveries in nature are a vehicle for improving society. Some examples include: 

a. Taq polymerase for polymerase chain reaction (PCR) from the bacteria Thermus 

aquaticus at Yellowstone National Park 

b. Insulin produced in E. coli, yeasts, or in plants for human injection via recombinant 

DNA technology 

c. Monoclonal antibodies produced by goats, rabbits, or other animals against hCG 

hormones for pregnancy testing 

2. Currently, research is being done to discover enzymes that can handle extreme conditions, 

such as those in high salt or those with little water. McMillan, Hepowit, & Maupin-Furlow 

(2016) have characterized the pyrophosphatase enzyme in the halophile, H. volcanii. 



 

a. Pyrophosphatase is required for cleaving pyrophosphate (PPi), which is produced in 

the hydrolysis of ATP into AMP. It is highly conserved because all organisms use 

nucleotide triphosphates, like ATP, to power endergonic reactions. In doing so, PPi is 

going to be a byproduct of those reactions, so every organism would need this 

enzyme. 

b. It could be useful to prevent unintended reactions during PCR and other 

biotechnology applications.  

 

Active Site & Side Chain Analysis (20 minutes) 

1. [5 minutes] Arrange students in groups of 4 and have them attempt to fit the substrates into the 

enzyme s active site using the Enzyme Active Site/Substrate Manipulative Activity. 

a. Walk around the classroom observing and correcting students attempts to fit the nucleotides 

into the active site. 

b. Remind students that hydrophobicity, hydrophilicity, and intermolecular force potential 

matter in how substrates interact with active sites. 

2. [15 minutes] Once finished with the interactive portion, transition students to working on the Side 

Chain Analysis Activity. 

a. Students will again be analyzing the chemical structure of enzymes, but this time with a 

greater eye on the chemical properties of the amino acid side chains. 

b. Students will compare an adapted active site model (without substrates, water, and cofactors) 

with a proposed active site model from 1992 and 1996. 

 

Enzymatic Activity Graphical Analysis (20 minutes) 

1. With students still in groups, give each group the Enzymatic Activity Graphical Analysis handout. 

2. [5-10 minutes] Have students discuss the experimental design and the results, and annotate each 

(especially if laminated) before looking at the questions. 

3. [10-15 minutes] Once discussed, students should transition to answering the questions. 

a. Remind students to connect this assignment to the Enzyme Active Site/Substrate 

Manipulative Activity as well as the Side Chain Analysis Activity. 



 

b. Walk around the room reminding students about the impacts of protein structure on protein 

structure, especially how the presence of salt and water is needed in the correct quantities to 

stabilize the active site. 

c. TIP: The most trouble portion of the analysis will likely be the control groups question, and 

it is an important focus of science and AP Biology curriculum. Remind students that control 

groups are used as a basis of comparison to the treatment groups, but they must explain 

HOW its used as a basis of comparison.   

 

ASSESSMENT SUGGESTIONS:   

Enzyme Active Site/Substrate Manipulative 

Formatively assess  comprehension of matching structures and intermolecular forces by going 

around the room and observing their trial-and-error attempts. 

 

Side Chain Analysis Activity 

Student responses can be collected and formatively assessed, or provide immediate feedback during the 

activity by walking around with the key. 

 

Enzyme Activity Graphical Analysis 

The big takeaway of understanding amino acid side chains, intermolecular forces, and protein 

structure is to ultimately explain how it impacts function. The Enzyme Activity Graphical 

Analysis can be used as a formative assessment to determine how well students made the 

aforementioned connection or as a summative assessment. 

 

MODIFICATIONS or EXTENSIONS: 

During the Enzyme Active Site/Substrate Manipulative Activity, on the laminated enzymes, 

students can draw in their molecules and annotate hydrogen bond interactions using vis-à-vis 

markers. 

 

AP Biology Investigation 13 focuses on enzyme activity and has been a focal lab in the AP 

Biology curriculum since its inclusion in the 2001 AP Biology Lab Manual. In the investigation, 

students will utilize peroxidase from turnips in order to determine optimum temperatures, pH, 

https://apcentral.collegeboard.org/pdf/bio-lab13-enzymeactivity.pdf?course=ap-biology


 

or other environmental conditions they decide. The investigation extends students graphical 

analysis from this lesson to devising their own graphs specific to enzyme activity. 

 

RESOURCES/REFERENCES:  

The College Board. (2012). AP Biology investigative labs: An inquiry-based approach. New York, NY: The 

College Board. 

Cooperman, B. S., Baykov, A. A., & Lahti, R. (1992). Evolutionary conservation of the active 

site of soluble inorganic pyrophosphatase. Trends in Biochemical Sciences, 17, 262 --- 266. 

McMillan, L. J., Hepowit, N. L., & Maupin-Furlow, J. A. (2016). Archaeal inorganic 

pyrophosphatase displays robust activity under high-salt conditions and in organic 

solvents. Applied and Environmental Microbiology, 82(2), 538-548. 

Heikinheimo, P., Lehtonen, J., Baykov, A., Lahti, R., Cooperman, B. S., & Goldman, A. 

(1996). The structural basis for pyrophosphatase catalysis. Structure, 4(12), 1491 --- 1508. 

doi: 10.1016/S0969-2126(96)00155-4 

 

Supplemental Videos 

The following video is incredibly helpful to have students watch before beginning the lesson and in each 

subsequent protein-related lesson. 

RCSB Protein Data Bank --- What is a Protein? 

 

The following three videos give general overviews of proteins, with Khan Academy focusing more on 

the chemistry structural specifics. 

RCBS Protein Data Bank --- What is a Protein? 3D Shape & Function 

Bozeman Science - Proteins 

Khan Academy --- Four levels of protein structure 

 

The three following videos explain, in increasing complexity of detail, the nature of enzymes. 

Amoeba Sisters --- Enzymes (Updated) --- Basic  

Bozeman Science --- Enzymes --- Intermediate 

Khan Academy --- Enzymes | Energy and enzymes --- Advanced 

 

https://www.youtube.com/watch?v=wvTv8TqWC48
https://www.youtube.com/watch?v=wvTv8TqWC48
https://www.youtube.com/watch?v=qBRFIMcxZNM
https://www.youtube.com/watch?v=qBRFIMcxZNM
https://www.youtube.com/watch?v=2Jgb_DpaQhM
https://www.youtube.com/watch?v=2Jgb_DpaQhM
https://www.youtube.com/watch?v=O5gN-IK6uKs
https://www.youtube.com/watch?v=O5gN-IK6uKs
https://www.youtube.com/watch?v=qgVFkRn8f10
https://www.youtube.com/watch?v=ok9esggzN18
https://www.youtube.com/watch?v=A90HKrgUOg0


 

For teachers engaging in the extension activity, the following video walks through the older AP Biology 

(2001-2012) version of the enzyme catalysis lab. 

Bozeman Science --- Lab 2: Enzyme Catalysis 

 

 

https://www.youtube.com/watch?v=hs75JmgGW5Y
https://www.youtube.com/watch?v=hs75JmgGW5Y


 

Enzyme Active Site/Substrate Manipulative 

 

Below is the active site of an enzyme. There are three amino acid residues shown below: Glycine 

(G121), valine (V81), and arginine (R180). For glycine and valine, the contribution to the active 

site is actually their backbone (carbonyl group and secondary amine group) rather than side 

chains. Your task is to take the four substrates and identify the two that possess the best fit in the 

active site. Be sure to flip the molecules over in order to see how the mirror image fits. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Questions and Thoughts to Consider 

When manipulating the molecules, try to visualize the fact that there are many enzymes in a cell 

with likely even more substrate molecules available. The molecules are randomly floating around 

in solution until their fit and attractive forces match appropriately with each other.  

 

Which two substrates fit the best? 

 

What was it that made them fit? Shape? Intermolecular force potential? 

Hydrophobicity/hydrophilicity? A mixture of all three?  

 
 

 
 



 

 
 

 
Enzyme Active Site/Substrate Manipulative 

Suggested Student Responses 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The following diagrams represent the best fits of substrates. In fact, adenine is a substrate for this 

enzyme. Hydrogen bonds are implied between adjacent hydrogen, oxygen, and nitrogen atoms 

due to their proximity. Guanine also has a potential fit, but the hydrogen of the secondary amine 

 



 

Side Chain Analysis Activity 

 

The following figure represents the active site structure of  inorganic pyrophosphatase adapted from 

Heikinheimo et al. (1996). The side chain residues of amino acids interact with inorganic pyrophosphate (not 

shown in this figure) in order to catalyze the reaction to two phosphate ions. Analyze the structure, paying 

attention to the side chains and their chemical properties, and answer the questions below. 

 

 
 

 

 

Analysis 

Write the name of each amino acid on the line adjacent to it. Predict what the numbers mean. 

 

 



 

Identify the number of side chains based on the following properties in the accompanying table: 

Special Cases          

Polar, Uncharged Side Chains        

Polar, Electrically Charged Side Chains       

Hydrophobic Side Chains         

 

Predict what common molecule is necessary to stabilize the active site based on their side chains.  



 

Side Chain Analysis Activity 

 

The following figure represents the active site structure of  inorganic pyrophosphatase with 

pyrophosphate stabilized inside (Heikinheimo et al., 1996). Again analyze the structure, this time paying 

attention to interactions between the side chains, substrate, and accompanying substances. 

 
 

Analysis 

Circle the following according to each color listed: 

Pyrophosphate (PPi) Water Metal Ions 

Red Blue Black 

 
The figure to the left is a proposed model in 1992 from the 

same researchers who published the model above in 1996. 

Explain the model changed over time by describing its 

similarities and differences. 



 

 
  



 

 

  



 

Side Chain Analysis Activity 

 

The following figure represents the active site structure of  inorganic pyrophosphatase adapted from 

Heikinheimo et al. (1996). The side chain residues of amino acids interact with inorganic pyrophosphate (not 

shown in this figure) in order to catalyze the reaction to two phosphate ions. Analyze the structure, paying 

attention to the side chains and their chemical properties, and answer the questions below. 

 

 
 

 

Analysis 

Write the name of each amino acid on the line adjacent to it. Predict what the numbers mean. 

 

 

Identify the number of side chains based on the following properties in the accompanying table: 

Special Cases          

Tyrosine 

Tyrosine 

Aspartic Acid 

Aspartic Acid 

Aspartic Acid 

Aspartic Acid 

Aspartic Acid 

Lysine 

Lysine 

Lysine 

Arginine 

Glutamic Acid 

Glutamic Acid 

Glycine 

1 

0 



 

Polar, Uncharged Side Chains        

Polar, Electrically Charged Side Chains       

Hydrophobic Side Chains         

 

Predict what common molecule is necessary to stabilize the active site based on their side chains. 

Given the great potential for H bonding, water is necessary to stabilize the active site. 

Side Chain Analysis Activity 

 

The following figure represents the active site structure of  inorganic pyrophosphatase with 

pyrophosphate stabilized inside (Heikinheimo et al., 1996). Again analyze the structure, this time paying 

attention to interactions between the side chains, substrate, and accompanying substances. 

 
 

Analysis 

Circle the following according to each color listed: 

11 

2 



 

Pyrophosphate (PPi) Water Metal Ions 

Red Blue Black 

 

 

The figure to the left is a proposed model in 1992 from the 

same researchers who published the model above in 1996. 

Explain the model changed over time by describing its 

similarities and differences. 
The model changes to include far more amino acid side chains 

within the active sites, more metal ion interactions, and a greater 

focus on the inclusion of water. The model retained the need for 

metal ion stability (going from 3 to 4) and also the presence of 

arginine and acidic amino acid residues. 



 

Enzymatic Activity Graphical Analysis 

 

McMillan, Hepowit, & Maupin-Furlow (2016) characterized the enzymatic properties of 

inorganic pyrophosphatase in Haloferax volcanii (HvPPA), a halophile isolated from the Dead 

Sea. Inorganic pyrophosphatase mediates the following reaction: 

 

→         °𝑓  
 

The researchers carried out a series of experiments to identify optimum conditions for five 

different environments: pH, temperature, salt, metal ion, and magnesium ions. In experiments A 

to C, HvPPA was equilibrated for 10 minutes at the pH, temperature, and NaCl concentrations 

before 0.25 mM PPi was added.  

 

Each experiment was carried out according to the conditions in the table below: 

Group A B C D E 

pH IV 8 8 8 8 

Temp. 42°C IV 42°C 42°C 42°C 

NaCl 3M 3M IV 2M 2M 

MgCl2 2.5mM 2.5mM 2.5 mM IV IV 

 

 



 

  

Data Analysis 

Identify the optimum condition in each of the 5 graphs. 

 

Group A B C D E 

Condition      

 

 

Predict the effects on the structure of the enzyme at temperatures and pH greater than 65°C and 

pH 10. 

 

 

 

 



 

 

 

 

 

 

 

 

Chemically and thermodynamically speaking, explain why enzyme activity is low, but not the 

lowest, at 25°C. 

 

 

 

 

 

 

 

 

 

 

 

 

Predict how the breakdown of inorganic pyrophosphate would be impacted without functional 

inorganic pyrophosphatase. 

 

 

 

 

 

 

Look at the enzyme active site from the previous activity. Use the model to explain why activity 

increases with increasing metal ion and MgCl2 concentrations. 



 

 

 

 
 

 

 

 

 

 

 

 

 

Propose ONE possible control treatment for each of the five experiments, and describe how each 

control treatment would increase the validity of the results.  

 

 

 

 

 



 

 

Enzymatic Activity Graphical Analysis 

 

McMillan, Hepowit, & Maupin-Furlow (2016) characterized the enzymatic properties of 

inorganic pyrophosphatase in Haloferax volcanii (HvPPA), a halophile isolated from the Dead 

Sea. Inorganic pyrophosphatase mediates the following reaction: 

 

→         °𝑓  
 

The researchers carried out a series of experiments to identify optimum conditions for five 

different environments: pH, temperature, salt, metal ion, and magnesium ions. In experiments A 

to C, HvPPA was equilibrated for 10 minutes at the pH, temperature, and NaCl concentrations 

before 0.25 mM PPi was added.  

 

Each experiment was carried out according to the conditions in the table below: 

Group A B C D E 

pH IV 8 8 8 8 

Temp. 42°C IV 42°C 42°C 42°C 

NaCl 3M 3M IV 2M 2M 

MgCl2 2.5mM 2.5mM 2.5 mM IV IV 

 

 



 

  

Data Analysis 

Identify the optimum condition in each of the 5 graphs. 

 

Group A B C D E 

Condition pH 8.5 42°C 3M NaCl 
1 mM Mn 

15 mM Mg 

25 mM 

MgCl2 

 

 

Predict the effects on the structure of the enzyme at temperatures and pH greater than 65°C and 

pH 10. 

 

At temperatures greater than 65°C and pH 10, the structure of the enzyme likely denatures. 

Intermolecular interactions, especially at the active site, may be disrupted by the lessening of H+ 



 

ions. Furthermore, because intermolecular forces are weaker than covalent bonds, higher 

temperatures can lead to the loss of secondary, tertiary, and quaternary structure. 

 

 

 

 

 

 

Chemically and thermodynamically speaking, explain why enzyme activity is low, but not the 

lowest, at 25°C. 

 

At lower temperatures, molecules move around less which decreases the likelihood that a 

substrate and enzyme would interact. Also, macromolecules can become less flexible at lower 

temperatures. Because active sites and enzymes require movement to change conformation, 

activity lessens with 

higher temperatures because the added energy to the system leads to denaturing of the proteins. 

 

 

 

 

 

Predict how the breakdown of inorganic pyrophosphate would be impacted without functional 

inorganic pyrophosphatase. 

 

°𝑓 - ), the breakdown of 

inorganic pyrophosphate into inorganic phosphate is spontaneous and will occur naturally 

without the help of an enzyme. It likely occurs much slower in nature without an enzyme than 

with one.  

 

 



 

Look at the enzyme active site from the previous activity. Use the model to explain why activity 

increases with increasing metal ion and MgCl2 concentrations. 

 

 

 
 

 

In the proposed active site mechanism, there are at least four metal ions (circled above) involved 

in stabilizing the catalysis of inorganic pyrophosphate. In order for HvPPA to function, it needs 

multiple Mn and Mg ions to function. Consequently, increasing metal ion concentration for Mn 

and Mg lead to increasing activity because it provides more ions in solution to facilitate catalysis.  

 

 

 

Propose ONE possible control treatment for each of the five experiments, and describe how each 

control treatment would increase the validity of the results.  

 

A: 

the environments provided. 



 

B: A sample held at 42°C because 42°C is the optimum growth temperature for H. volcanii. 

C: A sample held at 0 M of NaCl to confirm that salt is necessary. 

D: A sample without PPi to confirm that PPi is the only substrate in solution for the reaction. 

E: A sample without MgCl2 to confirm that MgCl2 is necessary. 

 

[Multiple answers can be acceptable. This gives a diversity of answers that may or may not be 

acceptable for each group.]



 

Teacher Notes 

Lesson 2: Keeping Active --- Exploring the active site of inorganic pyrophosphatase   

 

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             



 

             

             

             

             

             

             

             

               



 

Lesson 3 & 4: Finding Similarities 

Investigating evolutionary relationships at levels higher than DNA or protein sequences   

 

LESSON SUMMARY:  

Some gold standards for measuring evolutionary relatedness is looking at nucleotide and amino acid 

sequence alignments. This lesson reveals another method of showing evolutionary relatedness --- protein 

structure alignment. Students will BLAST nucleotide and amino acid sequences for the inorganic 

pyrophosphatase (PPA) of five species: H. volcanii, P. furiosus, E. coli, S. cerevisiae, and H. sapiens. After 

measuring evolutionary relatedness, they will spend an additional day modeling 3D protein structures of 

PPA in each species and level of similarity between each. 

 

STANDARDS: 

AP Biology NGSS NGSSS 

E.K.1.B.2 HS-LS1-1 SC.912.N.3.5 

Science Practice 1 HS-LS4-1 SC.912.L.15.4  

  SC.912.L.15.6 

  SC.912.L.18.4 

 

KEY QUESTION(S):   

How does pyrophosphatase in H. volcanii compare with other organisms in the tree of life? 

Can similarities exist when amino acids and nucleotide sequences differ greatly?  

 

LEARNING OBJECTIVES: 

The student will be able to... 

 

1. Compare 3D structure of proteins using modeling software. 

2. Create cladograms and data tables showing evolutionary relatedness. 

 

OVERALL TIME ESTIMATE:   

Advanced Preparation: 60-120 minutes. Time needed to install Chimera on each classroom/student 

provide the sequences and Protein Data Bank (PDB) files on an online course management system or 



 

preload them on each computer ahead of the lesson. Copies of the Sequence and Structural Homology 

of Inorganic Pyrophosphatase should also be printed (1 per pair). The majority of the time should be 

invested by the teacher to explore Chimera and NCBI BLAST, become familiar with its functions, and 

predict potential pitfalls unique to his/her own classes. 

Lesson: 100 minutes (2 50-minute classes) 

 

MATERIALS:   

Essential 

 protein modeling software 

Inorganic pyrophosphatase (PPA) PDB files 

PPA nucleotide sequences for H. volcanii, P. furiosus, E. coli, S. cerevisiae, and H. sapiens 

PPA amino acid sequences for H. volcanii, P. furiosus, E. coli, S. cerevisiae, and H. sapiens 

Sequence and Structural Homology of Inorganic Pyrophosphatase Handout 

 

BACKGROUND INFORMATION:  

The Basic Local Alignment Search Tool was produced by the National Center for Biotechnology 

Information in 1990 (Madden, 2013). The tool has progressed to have stronger computational 

algorithms and more options for analysis. Coupled with the growing number of nucleotide and amino 

acid sequences collected, BLAST is a powerful bioinformatics tool and often the start of many 

researchers genomic and proteomic work. BLAST operates by using algorithms to identify similar or 

identical sequences between a query string and reference sequence. The confidence in that match is then 

statistically determined and reported both numerically and graphically for the user. Sequences that have 

an E-value 1 × 10−4 are said to be homologous or related to the reference sequence (Lessick, 2010). 

Sequence identity (instances where aligned sequences are identical) are also graphically shown with the 

two sequences aligned on top of one another. Identical sequences mean the same nucleotide or amino 

acid is found in the same location between the two sequences. For amino acid sequences, positive 

matches (+) indicate chemically similar amino acids occupy that position (Lessick, 2010). Given 

impossibility of physically comparing homology between two distinctly different organisms, such as 

felids and Gram-negative bacteria, BLAST is a useful tool in identifying less visible similarities through 

nucleotide and amino acid sequence alignments.  

 

http://www.cgl.ucsf.edu/chimera/download.html
http://www.cgl.ucsf.edu/chimera/download.html


 

Chimera, on the other hand, helps to provide further insight about structural similarities when sequence 

is a molecular modeling software developed by the University of 

California-San Francisco in 2004 (Petterson et al., 2004). For this lesson, the functions of focus are 

Molecules can be visualized in ball-and-stick, space-filling, and ribbon structures. Specific amino acids, 

atoms, side chains, or higher levels of protein structure can be selected and contrasted against the rest of 

the molecule through the various selection tools available. This lesson focuses on the MatchAlign tool 

that takes two protein models and superimposes them together. From the superimposition, a root mean 

square difference in amino acid locations is calculated to determine structural homology. Four of the five 

sequences used in this lesson are from known protein structures accessible by the UniProt and Protein 

Data Bank databases. The H. volcanii protein structure has not yet been elucidated, but in this lesson, it 

a model was created using Protein Homology/analogY Recognition Engine V2.0 (Phyre2) (Kelley, 

Mezulis, Yates, Wass, & Sternberg, 2015). The engine uses existing protein structures to model 

inputted sequences of not-yet-elucidated structures. For H. volcanii, the model was based off the 

Arabidopsis thaliana inorganic pyrophosphatase, which may bias the results towards similarity to 

eukaryotic origins. 

 

REQUIRED STUDENT BACKGROUND KNOWLEDGE: 

Students should understand evolutionary relatedness, whether through sequences or structures. Students 

also know how to represent those similarities and differences through tables, cladograms, and 

phylogenetic trees. 

 

Students should have prior knowledge about protein structure, especially secondary and tertiary 

structure. Chimera will expose students to 3D models of proteins, so the ability to recognize structural 

features, especially alpha-helices and beta-pleated sheets, will help them comprehend structural 

homology better.  

 

 

ADVANCE PREPARATION:   

The University of California --- San Francisc  should be installed 

ahead of time on each computer used. At least an hour should be spent by the teacher familiarizing him 

https://www.cgl.ucsf.edu/chimera/


 

or herself with the software. Upload the sequences and Protein Data Bank (PDB) files on an online 

course management system or preload them on each computer ahead of the lesson. 

 

Print copies of the Sequence and Structural Homology of Inorganic Pyrophosphatase (1 per pair). 

 

ite can be a very powerful tool, but also confusing given the number of features 

and options that can be manipulated. It is highly recommended to walk through a video tutorial and the 

student section of this lesson before implementing it in the classroom. 

 

VOCABULARY:  

BLAST: Basic Local Alignment Search Tool, a tool using computer algorithms to regions of 

similarity among nucleotide or amino acid sequences. 

Cladogram: Graphical representation of evolutionary relatedness among species. 

Homology: Measure of the relatedness or similarity between two items, such as nucleotide 

sequences, physical structures, proteins, amino acid sequences, etc. 

PDB: Protein Data Bank, the repository by the National Center for Biotechnology Information, 

with structures and information of known proteins. 

Phylogenetic tree: Graphical representation of evolutionary relatedness among species, similar to 

a cladogram, but contains more information about the degree of change and time needed for the 

change to occur. 

RMSD: Root mean square difference is a statistical function that calculates the distances of 

amino acid residues between two superimposed structures. The function provides a numerical 

output that is interpreted as the confidence in structural alignment. The lower the value, the 

more aligned the two structures are. Values <2.000 indicate strong alignment.  

 

 



 

PROCEDURE AND DISCUSSION QUESTIONS WITH TIME 

ESTIMATES:   

Have a BLAST (50 minutes) 

1. [5 minutes] Explain to the students that they will be resuming their investigation of 

inorganic pyrophosphatase by exploring the homology of the enzyme among five species: 

three microbes, yeast, and humans. Fun fact: Pyrococcus furiosus was used only because of its 

resemblance to my last name. 

a. Ask students the following questions: 

i. How we can determine evolutionary relatedness between these organisms?   

ii. At the molecular level, what can help use quantity and describe those 

similarities?   

iii.  

b. Elicit thoughts on potential similarity between the five species with inorganic 

phosphatase and have them defend their viewpoints with evidence. 

2. [10 minutes] Arrange students in pairs at computers or tablets and have students watch the 

following video during class or for homework before class starts: Johns Hopkins University --- 

NCBI BLAST Tutorial. The teacher can also walk the students through the first BLAST 

alignment search with little impact on student experience (they will be doing numerous 

BLAST alignments). 

3. [25-30 minutes] Students will first identify common names of the species and the domain in 

which they are found. Students will then follow the instructions on the assignment in order 

to tabulate the homology between the five species for both nucleotides and amino acids. 

Walk around the room providing feedback and answering any questions the students may 

have. Below are some sample questions the students might have or you might want to ask 

(sample answers are in parentheses): 

o Why is there so little identity between the nucleotide sequences? 

 (Intronic regions in the case of H. sapiens, true lack of genetic between the five 

drastically different species, especially because of the environments H. volcanii and P. 

furiosus inhabit.). 

o What might be a better alternative to nucleotide BLAST?  

https://www.youtube.com/watch?v=HXEpBnUbAMo
https://www.youtube.com/watch?v=HXEpBnUbAMo
https://www.youtube.com/watch?v=HXEpBnUbAMo
https://www.youtube.com/watch?v=HXEpBnUbAMo


 

 (mRNA or amino acid sequences because they have introns removed in eukaryotes 

and have less redundancy [64 codons for 20 amino acids]). 

o What is the extent of similarity between yeast and humans? Is it the whole sequence or only a 

portion? 

 nucleotides for 

yeast and 25000 for humans). 

o Why is the human sequence so much longer than the other four species? 

 (Introns. Only about 1/25th of the entire sequence is coding.) 

o Predict why protein sequences between species X and Y are [insert value]. 

 (Answers will vary, but likely stem from environment and domain.) 

4. [5-10 minutes] Students should answer the first two questions before leaving class or entering class 

the next day. 

  

Modeling with Chimera (50 minutes) 

1. [5 minutes] Have the class hypothesize whether there should be any homology between the different 

PPAs.  

a. Encourage students to use their evidence from the previous day to support or refute their 

claims. 

b. Given the ubiquity of nucleotide triphosphates and their use as energy sources within living 

organisms, the need for inorganic pyrophosphatase should hypothetically show homology. 

2. [35 minutes] Arrange the students again in pairs with computers (tablets will not work for 

this lesson) and have them watch the following video: RCSB Protein Data Bank --- UCSF 

Chimera: Structure Comparisons. Instead of having the students watch the video, the 

software could be modeled in the next step below. 

3. Load Chimera and demonstrate protein visualization with the software, showing some or all of the 

following functions: 

a. Model the rotational keys needed to orient the protein in the proper viewing area. 

b. Different model views (ball-and-stick, ribbon structure, and space-filling models). 

c. Show how to select specific amino acids, their R groups, or the sequences. 

d. Remind students about protein structure, specifically how alpha-helices and beta-pleated 

sheets form. 

https://www.youtube.com/watch?v=oThN3LG8LQU
https://www.youtube.com/watch?v=oThN3LG8LQU
https://www.youtube.com/watch?v=oThN3LG8LQU
https://www.youtube.com/watch?v=oThN3LG8LQU


 

e. Walk through one alignment comparison and explain how the RMSD value can reveal 

information about structural homology. 

4. Allow the students to work in pairs on filling out protein structural homology table and have them 

answer the rest of the questions on the assignment. Walk around the class providing feedback and 

answering/asking probing questions, such as the following below: 

o How does your RMSD data compare to the sequence alignments? How do their alignments 

visually compare? Why might there be a difference? 

o Where is the active site on each of the PPAs?  

o What portion of the sequence do you think is retaining homology? The outer portion? The 

inner portion? The active site? 

 

ASSESSMENT SUGGESTIONS:   

Sequence and Structural Homology of Inorganic Pyrophosphatase 

Formativel

classroom and observing their use of the BLAST and Chimera tools. Because of the open-ended 

nature of the assignment, student understanding can be assessed by either collecting the 

assignment or leading a classroom discussion. Students likely will have different cladogram 

interpretations and the opportunity to present the information in a whole-class setting may lead 

to some revision of knowledge and interesting discussions. 

 

MODIFICATIONS or EXTENSIONS: 

, students 

H. volcanii

McMillan, Hepowit, & Maupin-Furlow (2016) includes the following amino acid residues: K31, 

E33, R45, Y57, D67, D69, D72, D99, D104, K142, E145, and K148. Displaying those R-

groups Chimera is possible using the Atom Specification tutorial.  

 

Students can also change the views from ribbon models to ball-and-stick models or space-filling 

models using the Molecule Display tutorial. 

 

http://www.rbvi.ucsf.edu/chimera/docs/UsersGuide/midas/frameatom_spec.html
http://www.rbvi.ucsf.edu/chimera/docs/UsersGuide/framecore.html


 

AP Investigation 3 has an inquiry activity with hypothesis testing and revision based on fossil 

remains and four collected DNA samples. The late Kim Foglia created a more scaffolded and 

guided version titled Lab 21 --- Using Bioinformatics to Investigate Evolutionary Relationships; 

Have a BLAST!  

 

 

 

RESOURCES/REFERENCES:  

The College Board. (2012). AP Biology investigative labs: An inquiry-based approach. New York, NY: The 

College Board. 

Kelley, L. A., Mezulis, S., Yates, C. M., Wass, M. N., & Sternberg, M. J. E. (2015). The 

Phyre2 web portal for protein modeling, prediction and analysis. Nature Protocols, 10, 

845-858. doi: 10.1038/nprot.2015.053 

Lessick, B. [JHU AAP]. (2010, July 29). NCBI BLAST tutorial [Video file]. Retrieved from 

https://www.youtube.com/watch?v=HXEpBnUbAMo 

Madden, T. (2013). The BLAST sequence analysis tool . In NCBI Handbook. Bethesda, MD: 

National Center for Biotechnology Information.  

McMillan, L. J., Hepowit, N. L., & Maupin-Furlow, J. A. (2016). Archaeal inorganic 

pyrophosphatase displays robust activity under high-salt conditions and in organic 

solvents. Applied and Environmental Microbiology, 82(2), 538-548. 

Pettersen, E. F., Goddard, T.D., Huang, C.C., Couch, G.S., Greenblatt, D. M., Meng, E. C., 

& Ferrin, T.E. (2004). UCSF Chimera - a visualization system for exploratory research 

and analysis. Journal of Computational Chemistry, 25(13), 1605 - 1612. 

 

Chimera Tutorials 

The following links are written tutorials by UCSF regarding the Chimera modeling software. 

Start here if you prefer text. For those who prefer videos, skip to the next set of links below. 

UCSF - Getting Started 

UCSF - Match-Align 

 

http://media.collegeboard.com/digitalServices/pdf/ap/bio-manual/Bio_Lab3-ComparingDNA.pdf
http://www.bcreek.k12.mi.us/sandbox/groups/advancedbiology/wiki/welcome/attachments/2ef5e/blastlab.pdf?sessionID=295638779c4e20c312ef01e8e7bb78ae2c5b837d
http://www.bcreek.k12.mi.us/sandbox/groups/advancedbiology/wiki/welcome/attachments/2ef5e/blastlab.pdf?sessionID=295638779c4e20c312ef01e8e7bb78ae2c5b837d
http://www.cgl.ucsf.edu/chimera/docs/UsersGuide/tutorials/menutut.html
http://www.cgl.ucsf.edu/chimera/docs/UsersGuide/tutorials/menutut.html
https://www.cgl.ucsf.edu/chimera/docs/ContributedSoftware/matchalign/matchalign.html


 

The following links are YouTube video tutorials by RCSB Protein Data Bank that visually walks 

through basic use of Chimera for this lesson. You may want to post these ahead of time on an 

online course management system so students are familiar with the software before they begin. 

RCSB Protein Data Bank --- UCSF Chimera: Basics 

RCSB Protein Data Bank --- UCSF Chimera: Structure Analysis 

RCSB Protein Data Bank --- UCSF Chimera: Structure Comparisons 

 

NCBI BLAST Tutorials 

The following links provide increasing levels of understanding related to using the BLAST tool. 

For conceptual understanding, students will be best served by the first link. For a full 

walkthrough explaining the steps of NCBI BLAST searches, the second link is much more 

helpful; however, because we are aligning two sequences, some of the steps do not apply. 

Bozeman Science --- Comparing DNA Sequences 

Johns Hopkins University --- NCBI BLAST Tutorial 

NCBI --- Webinar: A Practical Guide to NCBI BLAST 

 

Supplemental Videos 

The following videos help provide students with greater understanding of cladograms, 

phylogenetic trees, and the basis of evolutionary relatedness. 

Bozeman Science - Cladograms 

  

https://www.youtube.com/watch?v=hQxKYSUdiD8
https://www.youtube.com/watch?v=hQxKYSUdiD8
https://www.youtube.com/watch?v=eLxhKc7Ljjk
https://www.youtube.com/watch?v=eLxhKc7Ljjk
https://www.youtube.com/watch?v=oThN3LG8LQU
https://www.youtube.com/watch?v=oThN3LG8LQU
https://www.youtube.com/watch?v=OSKwuOccAak
https://www.youtube.com/watch?v=OSKwuOccAak
https://www.youtube.com/watch?v=HXEpBnUbAMo
https://www.youtube.com/watch?v=HXEpBnUbAMo
https://www.youtube.com/watch?v=KLBE0AuH-Sk
https://www.youtube.com/watch?v=KLBE0AuH-Sk
https://www.youtube.com/watch?v=ouZ9zEkxGWg
https://www.youtube.com/watch?v=ouZ9zEkxGWg


 

Sequence and Structural Homology of Inorganic Pyrophosphatase 

 

Because the genetic code links life on Earth, evolutionary relatedness can be determined through 

aligning DNA and even amino acid sequences. An often overlooked aspect is that structures of 

proteins can share homology as well. In this activity, you will BLAST nucleotide and amino acid 

sequences of five species to determine the relatedness of inorganic pyrophosphatase. After 

sequence aligns compared to the others. 

 

Table 1: Nucleotide Sequence Identity 

Scientific Name Common Name 

 (if available) 

Domain 

Haloferax volcanii   

Pyrococcus furiosus   

Escherichia coli   

Saccharomyces cerevisiae   

Homo sapiens   

 

Nucleotide BLAST 

Step 1: Go to NCBI Standard Nucleotide BLAST. Check the box for Align two or more 

sequences.  

Step 2: Paste the first PPA nucleotide FASTA sequence into the Enter Query Sequence  top 

box labeled Enter accession number(s), gi(s), or FASTA sequence(s)  and the second PPA 

sequence in the Enter Subject Sequence  bottom box labeled Enter accession number(s), gi(s), 

or FASTA sequence(s).  

Step 3: Under Program Selection,  click the More dissimilar sequences (discontinuous 

megablast)  option.  

Step 4: Click BLAST.  

Step 5: Look at identity ( Ident ) under the results to determine sequence portion with the 

greatest homology. Complete the table below with one-to-one comparisons. 

 

Table 2: Nucleotide Sequence Identity 

https://blast.ncbi.nlm.nih.gov/Blast.cgi?PAGE_TYPE=BlastSearch


 

Species H. volcanii P. furiosus E. coli S. cerevisiae H. sapiens 

H. volcanii      

P. furiosus      

E. coli      

S. cerevisiae      

H. sapiens      

NSS: No significant similarity. 

- : Indicates it is a comparison of the same organism. 



 

Protein BLAST 

Step 1: Go to NCBI Standard Protein BLAST. Check the box for Align two or more 

sequences.  

Step 2: Paste the first PPA protein FASTA sequence into the Enter Query Sequence  top box 

labeled Enter accession number(s), gi(s), or FASTA sequence(s)  and the second PPA sequence 

in the Enter Subject Sequence  bottom box labeled Enter accession number(s), gi(s), or 

FASTA sequence(s).  

Step 3: Under Program Selection,  click the blastp (protein-protein BLAST)  option.  

Step 4: Click BLAST.  

Step 5: Look at identity ( Ident ) under the results to determine sequence portion with the 

greatest homology. Complete the table below with one-to-one comparisons. 

 

Table 3: Protein Sequence Identity 

Species H. volcanii P. furiosus E. coli S. cerevisiae H. sapiens 

H. volcanii      

P. furiosus      

E. coli      

S. cerevisiae      

H. sapiens      

NSS: No significant similarity. 

- : Indicates it is a comparison of the same organism. 

 

3D Protein Modeling 

Step 1: Open Chimera, click File -> Open and open the first PDB model. 

Step 2: Click File -> Open again, and open the second PDB protein model. 

Step 3: Click Tools -> Structural Comparison -> MatchMaker. Select one model as the 

reference structure and the other model as the structure to match, and click OK.  

Step 4: Look at the bottom of the screen at the RMSD value, specifically Across all pairs  and 

record below. If the value disappears, click Favorites -> Reply Log to get the information. 

 

Table 4: Root Mean Square Difference (RMSD) Between Protein Structures 

Species H. volcanii P. furiosus E. coli S. cerevisiae H. sapiens 

H. volcanii      

https://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&PAGE_TYPE=BlastSearch&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=blastn&BLAST_INIT=


 

P. furiosus      

E. coli      

S. cerevisiae      

H. sapiens      

NSS: No significant similarity.    P: pruned (number of amino acids pruned in parentheses) 

- : Indicates it is a comparison of the same organism.  A: all (number of amino acids total compared in parentheses) 

  



 

Analysis 

Construct a cladogram using the amino sequence homology data. 

 

 

 

 

 

 

Predict why there are so few similar sequences among the nucleotide BLAST searches and 

compare to why there is greater sequence homology among amino acids. 

 

 

 

 

 

 

 

Infer the difference between the pruned amino acid sequences and the all amino acids  

compared in Chimera. 

 

 

 

 

 

 

 

Explain why there is minimal sequence homology with amino acids, but greater homology 

structurally speaking. Predict the conserved portion of the protein in your answer. 

 

 

 

 



 

 

 

 

A RMSD value less than 2.0 indicates strong similarity between structures. Justify the 

importance of inorganic pyrophosphatase in life based on RMSD values.    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Sequence and Structural Homology of Inorganic Pyrophosphatase 

 

Because the genetic code links life on Earth, evolutionary relatedness can be determined through 

aligning DNA and even amino acid sequences. An often overlooked aspect is that structures of 

proteins can share homology as well. In this activity, you will BLAST nucleotide and amino acid 

sequences of five species to determine the relatedness of inorganic pyrophosphatase. After 

sequence aligns compared to the others. 

 

Table 1: Nucleotide Sequence Identity 

Scientific Name Common Name 

 (if available) 

Domain 

Haloferax volcanii NA Archaea 

Pyrococcus furiosus NA Archaea 

Escherichia coli NA Bacteria 

Saccharomyces cerevisiae Yeast Eukarya 

Homo sapiens Humans Eukarya 

 

Nucleotide BLAST 

Step 1: Go to NCBI Standard Nucleotide BLAST. Check the box for Align two or more 

sequences.  

Step 2: Paste the first PPA nucleotide FASTA sequence into the Enter Query Sequence  top 

box labeled Enter accession number(s), gi(s), or FASTA sequence(s)  and the second PPA 

sequence in the Enter Subject Sequence  bottom box labeled Enter accession number(s), gi(s), 

or FASTA sequence(s).  

Step 3: Under Program Selection,  click the More dissimilar sequences (discontinuous 

megablast)  option.  

Step 4: Click BLAST.  

Step 5: Look at identity ( Ident ) under the results to determine sequence portion with the 

greatest homology. Complete the table below with one-to-one comparisons. 

 

Table 2: Nucleotide Sequence Identity 

https://blast.ncbi.nlm.nih.gov/Blast.cgi?PAGE_TYPE=BlastSearch


 

Species H. volcanii P. furiosus E. coli S. cerevisiae H. sapiens 

H. volcanii - NSS NSS NSS NSS 

P. furiosus NSS - NSS NSS NSS 

E. coli NSS NSS - NSS NSS 

S. cerevisiae NSS NSS NSS - 75% 

H. sapiens NSS NSS NSS 75% - 

NSS: No significant similarity. 

- : Indicates it is a comparison of the same organism. 



 

Protein BLAST 

Step 1: Go to NCBI Standard Protein BLAST. Check the box for Align two or more 

sequences.  

Step 2: Paste the first PPA protein FASTA sequence into the Enter Query Sequence  top box 

labeled Enter accession number(s), gi(s), or FASTA sequence(s)  and the second PPA sequence 

in the Enter Subject Sequence  bottom box labeled Enter accession number(s), gi(s), or 

FASTA sequence(s).  

Step 3: Under Program Selection,  click the blastp (protein-protein BLAST)  option.  

Step 4: Click BLAST.  

Step 5: Look at identity ( Ident ) under the results to determine sequence portion with the 

greatest homology. Complete the table below with one-to-one comparisons. 

 

Table 3: Protein Sequence Identity 

Species H. volcanii P. furiosus E. coli S. cerevisiae H. sapiens 

H. volcanii - 49% 40% 29% 30% 

P. furiosus 49% - 43% 27% NSS 

E. coli 40% 43% - 31% 27% 

S. cerevisiae 29% 27% 31% - 53% 

H. sapiens 30% NSS 27% 53% - 

NSS: No significant similarity. 

- : Indicates it is a comparison of the same organism. 

 

3D Protein Modeling 

Step 1: Open Chimera, click File -> Open and open the first PDB model. 

Step 2: Click File -> Open again, and open the second PDB protein model. 

Step 3: Click Tools -> Structural Comparison -> MatchMaker. Select one model as the 

reference structure and the other model as the structure to match, and click OK.  

Step 4: Look at the bottom of the screen at the RMSD value, specifically Across all pairs  and 

record below. If the value disappears, click Favorites -> Reply Log to get the information. 

 

Table 4: Root Mean Square Difference (RMSD) Between Protein Structures 

Species H. volcanii P. furiosus E. coli S. cerevisiae H. sapiens 

H. volcanii - P: 0.772 (165) P: 0.840 (150) P: 0.891 (134) P: 0.999 (131) 

https://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&PAGE_TYPE=BlastSearch&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=blastn&BLAST_INIT=


 

A: 0.938 (172) A: 1.747 (172) A: 4.837 (166) A: 4.452 (173) 

P. furiosus 0.938 - 
P: 0.715 (156) 

A: 1.345 (167) 

P: 0.856 (130) 

A: 4.701 (166) 

P: 0.913 (130) 

A: 3.272 (165) 

E. coli 1.747  - 
P: 0.826 (99) 

A: 5.612 (170) 

P: 0.934 (94) 

A: 6.552 (166) 

S. cerevisiae    - 
P: 0.868 (227) 

A: 2.104 (273) 

H. sapiens     - 

NSS: No significant similarity.    P: pruned (number of amino acids pruned in parentheses) 

- : Indicates it is a comparison of the same organism.  A: all (number of amino acids total compared in parentheses) 

  



 

Analysis 

Construct a cladogram using the amino sequence homology data. 

 

 

 

 

 

 

 

 

Predict why there are so few similar sequences among the nucleotide BLAST searches and 

compare to why there is greater sequence homology among amino acids. 

 

Nucleotide sequences involve introns in eukaryotes, which may lead to less alignment, but more 

importantly there is redundancy built into the genetic code. There are 64 codons for 20 amino 

acid/start/stop sequences. One codon might code for lysine, while a different codon might code 

for the same amino acid. Despite coding for the same amino acids, accumulation of differences 

might build up enough to lack significant identity. Furthermore, similar amino acids can have 

similar functions and be substituted with minimal effect on final protein structure or function.  

 

Infer the difference between the pruned amino acid sequences and the all amino acids  

compared in Chimera. 

 

Pruned amino acids are those amino acids remaining after those deemed to be outside the range 

of best fit (<2.0 RMSD) are removed. Consequently, the pruned RMSD will always be closer to 

0 than the RMSD for the entire structure. It is still helpful to see how many amino acids were 

retained after pruning compared to the entire sequence length in order to see how much of the 

protein fits well.  

 

Explain why there is minimal sequence homology with amino acids, but greater homology 

structurally speaking. Predict the conserved portion of the protein in your answer. 

 

E. coli 

H. volcanii 

P. furiosus 

H. sapiens 
S. cerevisiae 



 

There are sets of amino acids with R-groups that have similar chemical properties. When 

folding, they retain similar structural details despite having different identies. The conserved 

portion is likely the active site. 

 

A RMSD value less than 2.0 indicates strong similarity between structures. Justify the 

importance of inorganic pyrophosphatase in life based on RMSD values.    

 

In each protein structure, significant portions of the polypeptide are retained after pruning. The 

smallest retained amount is between E. coli and humans with 94/166 retained. Likely the 

retained portion with the lowest RMSD is the active site, as even in the halophile H. volcanii, 

the active site is still highly conserved (McMillan, Hepowit, & Maupin-Furlow, 2016). The 

most significant differences in structure are the exterior of the protein where each organism has 

specific environmental conditions to contend with. Consequently, PPA is important for life 

based on the low RMSD values.  



 

Teacher Notes 

Lessons 3 & 4: Finding Similarities --- Investigating evolutionary relationships  
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CONTENT ASSESSMENT: Provide a pre/post test for the curriculum, and provide 

an answer key for teachers.  

 

  



 

Content Area Expert Evaluation 

 

Thank you for reviewing Briny (Archaea)bacteria curriculum.  Please review the entire curriculum 

and then complete the questions below.  You are welcome to insert comments directly in the 

manual as well as in the section provided below.  Comments and suggestions are greatly 

appreciated! 

 

Reviewer name:              

 

Date reviewed:      Email:          

 

Employer:      Department/Division:        

 

Job title:               

 

Part I:  For each item below, please indicate your response to each question as it relates to the 

curriculum overall by circling Yes (Y), No (N), or Undecided (U).   

 

Is the science content in the curriculum accurate? Y N U 

Is the science content in the curriculum current? Y N U 

Is the science content in the curriculum important for science literacy? Y N U 

Is the content in the curriculum related to major biological concepts?  (e.g., 

molecular genetics) 
Y N U 

Is the content coverage in the curriculum thorough and complete? Y N U 

Are potential misconceptions adequately addressed? Y N U 



 

Is the content in the curriculum properly sequenced for a novice? Y N U 

Are there additional concepts that should be included?  (If yes, please 

elaborate below.) 
Y N U 

 

  



 

Part II:  Please include below any comments or suggestions about the curriculum. 

General comments about the overall curriculum:  

             

             

             

             

              

             

              

             

              

 

 

Comments regarding individual lessons: 

Lesson 1: 

Pretty & Pink 

 

 

 

Lesson 2: 

Keeping Active  

 

 

 

Lessons 3 & 4: 

Finding Similarities 

 

 

 

Future Lessons 

 

 

 



 

Extensions 

 

Teacher Feedback Form 

 

Thank you for reviewing Briny (Archaea)bacteria curriculum.  Please review the entire curriculum 

and then complete the questions below.  You are welcome to insert comments directly in the 

manual as well as in the section provided below.  Comments and suggestions are greatly 

appreciated! 

 

Teacher name:               

 

Subjects taught:         Grade levels taught:      

 

School:        Email:         

 

Part I:  Evaluation of the entire curriculum. 

 

Section A:  For each item below, please indicate your response to each question as it relates to the 

curriculum overall by marking Strongly Agree (SA), Agree (A), Undecided (U), Disagree (D), or 

Strongly Disagree (SD). 

 SA A U D SD 

1. Are the experimental procedures appropriate for your students?      

2. Are the topics addressed important for your course objectives?      

3.       

4. Are the topics addressed interesting to your students?      

5. Is the depth of coverage of topics appropriate?      

6. Is the overall quality of the curriculum satisfactory?      

7. Is the content in the curriculum properly sequenced?      



 

8. Is the content in the curriculum adaptable for a range of student 

ability levels? 
     

 

Section B:  Please provide additional comments pertaining to the curriculumoverall. 

 

Are there any topics/sections that should be added to/deleted from the curriculum?  If so, please explain.  

              

              

               

Additional comments:             

              

              

               



 

Part II:  Evaluation of individual lessons. 

Section A:  For each question below, please indicate your response for each specific lesson by marking High (H), Moderate (M), Low 

(L), 

or 

Not 

Appl

icabl

e 

(NA)

. 

 
Lesson 1: Pretty and 

Pink 

Lesson 2: Keeping 

Active 

Lessons 3 & 4: Finding 

Similarities 

 H M L NA H M L NA H M L NA 

1. Is the amount of teacher background 

information sufficient? 
    

        

2. Do the time estimates seem reasonable?     
        

3. Is the amount of advance preparation 

reasonable? 
    

        

4. Is the procedure clearly stated?     
        



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Is the suggested assessment sufficient?     
        



 

 

 

 

 

  



 

 

Section B: Please provide additional comments pertaining to each specific lesson 

Lesson 
Are there any topics, sections, or resources that 

should be added or deleted? If so, please explain. 
Additional Comments 

Lesson 1: 

Pretty & Pink 

  

Lesson 2: 

Keeping Active  

  

Lessons 3 & 4: 

Finding Similarities 

  

Future Lessons 

  

Extensions 

  



 

Student Feedback Form 

 

Name:         Date:        Grade Level:     Sex:   M    F 

School Name:        ame:        Subject:        

 

Part II:   

Secti

on 

A:  

Eval

uatio

n of 

indiv

idual 

lesso

ns. 

 
Lesson 1: Pretty and 

Pink 

Lesson 2: Keeping 

Active 

Lessons 3 & 4: Finding 

Similarities 

 H M L NA H M L NA H M L NA 



 

For 

each 

quest

ion 

belo

w, 

pleas

e 

indic

ate 

your 

response for each specific lesson by marking High (H), Moderate (M), Low (L), or Not Applicable (NA). 

 

 

 

 

 

 

 

 

 

 

1. Is the amount of teacher background 

information sufficient? 
    

        

2. Do the time estimates seem reasonable?     
        

3. Is the amount of advance preparation 

reasonable? 
    

        

4. Is the procedure clearly stated?     
        

5. Is the suggested assessment sufficient?     
        



 

 

 

 

 

 

 

 

 

 

 

 

 

 

Section B: Please provide additional comments pertaining to each specific lesson 

Lesson 
Are there any topics, sections, or resources that 

should be added or deleted? If so, please explain. 
Additional Comments 

Lesson 1: 

Pretty & Pink 

  



 

Lesson 2: 

Keeping Active  

  

Lessons 3 & 4: 

Finding Similarities 

  

Future Lessons 

  

Extensions 

  

 


